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ABSTRACT

An objective of this research was to develop the remedial computer assisted
instruction on usage of the Netscape Electronic Messenger for officers of
King Mongkut's Institute of Technology Ladkrabang (KMITL).

Population of this research was lecturers and officers from different affiliated
units in KMITL, who had attended the training course of using the Netscape Electronic
Messenger. The sample consisted of ten volunteers, three lecturers and seven officers.

The computer assisted instruction programme and the competency
assessment in term of check list were used as the research tools.

It was found that the computer remedial assisted instruction had 91.56/89.69

effectiveness, which was higher than that of expected values (80/80).
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600,000 (a3aslussuy LLa:Li’iaﬁumas’tﬁmﬁmqﬂsu 26 9 1udl w.e. 2537 $1maniA3al
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aananoadnnIahng (udu Lm:ﬁﬂu‘l’&’mu’aumaﬁﬁﬂmum’%aaﬂauﬁ’:ma%ﬁauqﬂﬂa
AdadaudnanlldiniTussnapRuiiuan

2.2.2 duitaasiiva wlizindlne

% UAaNEA (2539 : 37-39) lensnteduaaiifialulsznalnyin
Sudulull w.e. 2530 awinmdpsarauaiuni  uazaoiwnaluladuvsiaidy (AIT)
\didaudainsosifinauaasitniugsaananodidnniafindnuumineaswadin
Uszinaaasanid lasldmelnsdwidadaivdidayanuriumalaigy Fanmsoamande
anfugeandnldiolunslnmalng Wefussayaiuaminmasssmmeiund
uazgontiumaluladuiaoids Suazdnts voetuldluduanuiuios 2,400 dade
Surft rintiu Q’L'Eu?mwwmuﬁl.ﬁnmaﬁﬂﬁﬁammszﬂuwﬁﬂmé‘uﬁv'mmuﬁma:
0191359 NuANeadug s msduseeyalagldrsasindwrisondaseriuiiu

ATINID vL:Ji"JmSL%amiaﬁuﬂﬂamamw"mzjmw‘”sawasvﬁﬁqrﬁuﬂaqﬁu
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gonnlull w.e. 2535 qmamﬂﬁwﬁwmé“u‘lﬁ'vﬁnwsn'mvﬁauda%’um'ﬁaga
fuswaaiiauuusswlafiiluatiusn duenusa 9,600 dadedwiit lasidousaitiu
\3atneBwaaiiilafi UUNET Technologies ffmﬁ'lwﬁh-?'iu"]m&'lﬁ'u“%nw‘ﬁumm’tﬁm (ISP)
Tuanizowin uazgudinaluladdidnnisfinduazaaufaaeiuvsmd (NECTEC) file
Foudanauaae fuesamiumsdnmmelulsznadiwan 6 uwindidaniu ey
vimsdumeiiilamolulszinaagwanysoiuuy Ysznaudisymainysiuminman
gontwnaluladursiaids amIno usITAUATUNT LUAINA UM INNRUTITNAEAT
LazanAnmsninsasmaad laodoniedetnsilinlngans (Thai Socical / Scientific
Academic and Research Network) @a1flumslfiuduaaiiiamomsfinsuaside
lasianie 5u|.ﬂuqﬂﬁ"w°waa‘u’%msﬁumaﬂﬁﬂluﬂs:mﬁ'lnu Tauns 6 ursezls
ﬂauﬁqmaf‘ﬁqmmmtﬁwﬁﬂmé’mﬂuqmﬁ*mi’ur?iamia%’uﬁoﬂ]'agaﬁucimﬂ‘s:mmﬁm
ALAEN

gotumaluladwszasmnddnmnnsmaniziy Iaiimssanaszuy
\atnunaufuaad e imImafeudoiaiasnauiameTuadgmiug uaaud
T w.e. 2535 sEULLAI e DM TIRAYIEDN WY Lﬂuﬁmﬂﬁaﬁagmn%ﬂﬂsams
unuilauialisa (Campus Network) ﬁL“i‘iaaﬂmizumauﬁama?‘uamnﬂm:'lﬁawiaﬁams
uamﬂ‘éuuﬁagamuluwmﬁm nunasenlpseiotonamuanelugoniug whiu
s:‘.uu‘éuma%’tﬁ@m'mn'mﬂ"’sa'ﬂ'lm:aaguﬁtnﬂTuTﬂE‘ﬁLﬁnmaﬁnéua:ﬂauﬁdmaﬁm\a'mﬁ
(NECTEC) N3:N3I93ingnaaas (§314a Lﬁuqqum’ﬁﬂ‘{. 2541 : 2)

wasminludl we. 2536 wistisvasingmsfusisueuisansuinndh
\oudanuannumsAnm ua:ﬂm;muwaﬁgmmﬁu'fu Wi 19 Ui tlsznaudis
AoUluIZAUANANINIIUIN 16 UHI UasMIIENINIFINGEN 4 Uy dedldusng
N wuamnedldifinesnitising 05 64 nladareiwif Tudnniteases
vlwisendandanntszmaln m'ﬁ']gim'%a'ﬂ']U'uao‘ﬁumaﬁﬁmﬁmﬂuaaami e ld
frssdonuuasniule Luﬂmﬂ%mﬂu@ﬂ%é’ﬂ‘ﬂaomnﬁw‘ifiauﬁaﬁuﬁumaﬁﬁﬂ Wil
awaanInluminma uazlull w.e. 2587 lewmoiaiatisesnldn yudums
LB DU AR LNUITIRS 27 MIBU wiadusnugaunm 20 uWI uREwIIB
TITNT 7 U “ﬁa'lﬁ'lﬁ’u%ms‘éumaﬁﬁﬂaﬂwaauuﬂsrﬁuuu §ia E-Mail, Telnet, Ftp,
Gopher, uaz World Wide Web wia WWW ta3atinsaaufiniaasiulszinalnsiinnsuee
ﬁ?uﬁu%uﬁ‘ﬂﬂq sunadewtumeu wa. 2537 Usanalnofietetiodendonwiamu
35 1a301ny L TunauRaeIFY 1,267 Ladas Tidandadhiudwaatiia

Viumeneg  Susesdiudslpmivesmislfnudueefifialulsunalnouasd
anudasmslfwRunndu  msgemsuislszmalnouszasinsinsdnriuiatszina
npdsldsudanuuseniensuiisuladalivimdwasiiia  lasusniuieietnoves
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Inpss Buanguduimiduiaadifialsznelng (Intemet Thailand Service Center
ITSC) 139N KSC ComNet 131 Loxinfo 131 Infonews ludu vinlwuinisduiaatiia

Tudsznalnenszaaangrani

2.2.3 msrdszlemianndniaaiing
Gerald Lﬁuaquﬂiﬁﬂ§ (2541 : 1-6) lenanile Buaadidaduaiatng
aoufunasumnalwgfifaudanuielatnaoufiameiimlan vilwiduunasdoys
:Jmma"?iﬁ’lmsﬂﬁuﬂi’ﬂﬁnnﬂszmﬂ udslozinsdunmsdns duginansd
GIUAIEITURZNTU LA uaﬂmnﬁﬂ’ou‘Jsz:Iu'ﬁﬁ'lumﬁueiaﬁagmmms'l@"lunmﬁ"
57 WFedlgdeias mmmdﬂ]'a;gaﬂauﬁdmaﬂugﬂuummG)"l@T 1w unTaya
Mdudonna faenus Junmn LLﬂ:‘ﬁE]HﬂL%UGVLﬁ Hudu farin Bwapiiiindadiuinaslu
wapluuy lazanauveaniinu 2 ndulng 9 lédun U3MITuMIReRT UazLINTeY
MIAUM TR
1. UdmsswuniTRes s Lﬂuu?m'sﬁ"ﬁwlﬁ;ﬂ'ﬁmmmﬁﬂ@ia‘?uz\iﬁaga
LLamﬂﬁmﬁ’u‘lugmmualﬁnmaﬁnﬁ “’ﬁanm‘i‘auanﬁuml“ﬁiiwgnni’lmsﬁwiauuu
5ITUAN leur
1.1 aanInudiEnnIaiing (Electronic Mail %38 E-Mail) 1Tu13n17
Sugsranangdidnmadndmoluamsunais lidmanauarazsens lasdsouas
iulidasagranasluaidaniu u’%m‘siﬂu‘?iﬁuumaa;ﬁ'ﬁ‘ﬁumaiﬁmmn uaeld
Urelomillaagndlunmisdadasznivdizouwivgman
1.2 FUNUILDLUDanLaN Lﬂuu‘%m'sﬁ;ﬂ'ﬁ’mm‘mﬂﬂﬁmauﬁmﬂﬁﬂuﬁuG]

U

Tuduaefulaldlunadoans lasmsRaih Wnedduasa 19lusunnfidadn Talk
wiauiuluanme Chat

1.3 LaWAN (FTP : File Transfer Protocol) Lﬂ%ﬂ%ﬂ’)ﬂauﬁ’lﬂ“/\lﬁﬁ'm&ﬂ
anméaﬂ’aga‘fm‘%yndw W& EsWLe3  (File Server) andinaaiaiaaivadfls
noufaasing MadgIzuY (Login) ﬁjvlﬂél.ﬁifwna‘fﬁ?u;ﬂ“ﬁ'ﬂauﬁamafﬁaatﬂuam%ﬂ
voIgudnaNiLaed Lﬁiamgruuw'lﬁ’ﬁ%aLLa:‘sﬁ'mhumaaguﬁﬂauﬁfama‘?ﬁu 9

1.4 naLiia (Telnet) Lﬂum‘nif'uj's:umauﬁamafmﬂﬂa (Remote
Login) Lﬁa;ﬂ’ﬁﬁaanﬁ‘li&’lmﬂ%‘aaﬂauﬁdLmai'Lﬂ‘i‘aq'é‘uﬁa;‘ivlﬂaaanvLﬂ

15 seUULeetne Usenet Wlussuuiaiotnonoufinaasiizenloaiu
duszuuTiiiion (BBS : Bulletin Board System) daiilwnisfiasnsluiFosinamaniunan
Iﬂﬁﬁ%al,‘%'um"mtimh'am‘s (Newsgroups) fiundvssinaionigmiadinnes

2. vineumTays Lﬂuu‘%mi'?'iQ’l‘ﬁmmmﬁumﬁaQaﬁﬁaqmﬂ@'ﬂunm

aFuazdszndad line Lﬁaamnamﬂm‘tﬁ@ﬁwsiwﬂ'agamnLﬂ?aﬂjwﬂauﬁama%

o o o a g'a [ vV v
ﬂ?IﬂﬂlLﬂ:Nﬂﬂ%ﬁnﬂﬂ‘i:Lﬂ'ﬂ Uiﬂ'l'iull“ﬂ']ﬂ?:nulﬂl-ﬂﬂnl’ﬂ vl.ﬂl.l;ﬂ
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‘e = P a ) a
2.1 913% (Archie) sruviduaiianusraninyluaiatuduwaaiiia
vV & L v L d (] 3 =3 vﬂl > ‘.' v v d -3
AlFuinsezvaidr dumdeya wlinmuiwiulinladn dielddeysvasenuiiiu
- L v A3 W ° L ) & A J L v
usrezanansai lWiudayaldnndeas mavadlyfudutayaluszunis dliezdes
vihgszunlfianiBidiwines (Archie Server) uaziihgundstayadialusunsuimaliia
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A3 s ¥ & ar ] J o 3 o Ld J v o L {
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lUdngfWineinaug
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] VW
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LY ' i - e v W -l o (")
vuguTayad1e 9 uwaiatnoBumaiiie Soldunudeysuazasrridamivaum
Tayadwrnannienld wedmasanuazanlidllunsdumiliadhgauddoyanu uas
o o Al o & A s [ANY) A w T - vy
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25 Aaalaatiug (WWW : World Wide Web) tTluu3msaumiuas
v i oo Y A Y o
uansteysfisunsalodleludinouyg Tduunlouwam Tasmagaalousslandodoys
MnunastayIad il 3L (WWW Server) doyariadhadiivdmunaniaadldnsdoany

a g e oa = d2 2 da a
nuaanes Eﬂfnw LLAZLREN ituuumtﬂuﬂuﬂwﬂammamﬂuﬂaquu

2.2.4 F5iHoudaiingiaiate

f3Fnaideusiold 3 wuy

1. midendalapays vanuv HlFTiaT01ns LAN fiagnazideudny
swapfifiaielfusmilansaninan 24 51lus lavdosneuiinefiudasdl IP Address
Alasuandwnanoiaudreda nwr‘ﬁ'audaﬁw"lﬂ”[m'lﬁqﬂnmf Router ¥wiifiiilu
Gateway (Baulaiaiatnnidnenniu mué’mvnpm‘éanmaﬁl'ﬁl.%anmiﬁﬂﬂmﬁ'nga‘lumi
ﬁaﬁagasﬁm@i 9,600 dadeduwfi auily 2 wnzdadadiuh Lfiat%"au@iaﬁ’mﬁw&’l'ﬂ”tﬂ"‘iaa
nauftaaslua3atne LAN Amantalduiniidne g vesduinaiiialaatnensudiu

2. maBaudarmaiatneInsdwiuwy Dialup IP flfuimadessdaniu
suBnvasmiisnugliimiduaaiiia (1SP) tepalFUInIuLL Dialup IP wiaiilu
msldmsuunmiin lasdendedoluduuazaainsdwiiiufedygio uazld
luslanea SLIP/PPP

3. madeandarwaiatoinsinlaglfnwiunaiivavesdwaniiia
Humsdadaufildnuduaaiiiiammzuuussnsviswuuimeitia laolfluduuss
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-
2.2.5.1 Boiaspuaznanganlod
TuieSetneduaafifiaimsldnunowasled (P Address) uaz
P =1 a = o - - &l A' i =1 [ o & 3 6 A -
'naLﬂums:qmmmiaoﬂaummammauag'lumiamu Lideaiuladiouriniaiaios
as f v o P s R - & oA o at
WEiinesesdasiinunoatlofuazdon s nuuazinisasbouasinnuananoay lanae

a = € _a o v A a4 oA € & =
dovedluguuuiidnluawinagmvesasdniiimiiiguaiaiainuduaefidaiu

v o v & - o - A " ' - -
Hrimua damssniusiasneniaineiidaudeagmaninizszydisTaniominuiay
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dutnafiila iaizadamiwna ulafinszrauindndrgunmeanansz i dsludeit
Usznaual8d1i1 chaokhun, kmitl, ac, th 33utin 4 f Tﬂnﬁtwia:ﬁ’m‘uﬁwgm o
o &

1 1 ﬂ. - - o 1 ] 1 a W 1 [t o
WWIavLARETaRINNIDIAININILRs I IR bl U 1é PuanuAF IR
o A
laseaisvaite

2.2.5.3 waulaylon
winualafiivwiannuua 4 luyl (Byte) 3a 32 On (Bit) law
waszluriaansofidlaaeus 0 fs 255 uszudazluyiazdasaudioge () laglidasiu

as

84919 athatn waoaulew. 161.246.10.21 iwnmanoaylafvasaIandiviaesy

2.

nlgehdwaafifadivieivsssmiumaluladwszaauinduigunmsaansaiy
Wuen

2.2.5.4 Holaiuw
sznavueie 2 &4
1), Gondaslulaiun
2) Falawu
§I0tNTBLABILEY chaokhun.kmitl.ac.th Usznaudande
widaslulaiun @0 chaokhun us=Folaum fe kmitlacth Telawudefeveaiadate
ﬂauﬁaglum‘%aﬂwﬁmﬂaﬁﬁﬂ
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=l a i
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I¥5uudiEnnsefindiliuadasiislumadenuszdnanameananslwisadu qﬂf"i 2 lfszuu
s & nmseindlunniudadonuaziranaetnias Wdfivinmslseddsds luuuy
FITUAN qm"'i 3 Lﬂus:uun'rsmvl,ﬂmrﬁﬂﬁLﬁﬂﬂiﬂﬁﬂé"?’iaugitﬁLLuu 24178139 AAN
ELﬁnmaﬁnﬁﬁma%ﬁﬁamm@’m uszds lU@asBiannIafindiarananslanoms yuues
dninziiwinlswdddannsafindden 9 Wannlfastae
3 AUAR IR ATIIRIINITG | ANRINANENTTNEMINLTNW
Insinauazlnsdwyianna  (CCITT) %a"lﬁ'mum‘sgﬂuﬁgﬂuuuuﬁﬂaamqu:rfjt.ﬁmﬁ'u
lswddaidnmsaingly - luswdldaiinnsefndezgnusdlusmwuiadauuasszuy
AT E I eBlannTafing i:uumsaa'ﬂ'nmsé’anﬁnmmsn'lﬁ;j}’lﬂm:nuﬁu
LLamﬂﬁUuﬂnmﬂﬂumﬁmﬁuLLa::{fmzia'l.ﬁ’s:u11msﬁa‘u’nmsfuawﬁwuﬂ'lﬁ;ﬁ‘ﬁﬁaﬁ
HlE (User) Lﬂuqﬂﬂaﬁﬁaqﬂﬂalﬂﬁmﬂﬁﬂauﬂdmm‘f AlFazuunaning
43N (Originator) Lijadaw92603 wiaflufu (Recipient) Wasutnaes mivinsad
°d’naﬁifum:ﬁnwumgﬂttuumaa&h'Jm‘nm:m’lummmﬁ%:ﬁﬂﬁ;ﬁ'ﬂammms"l.@T
lfidhansdessupinmslasdiunadunugls  (User Agent) Gl
Q’awmgm'lﬁ%’uﬂ’nmsﬁ?u fo doslinatiinvesyldniafiszuunmeiildiuiulungs
etz iudnauasliardilumdaslign dnmindasanluszuudinarain
mﬂawaaﬁ’agaﬁgnmunammumoszum:ﬂsznauﬁdu 7899AUaNe (Envelope) s:q%‘a
W3 waziilam (Content) 78911787 AMUUANANITEWITBIRARINBUaz HEM T AN
ﬁwﬁm‘,mn'lm:uumiﬁiow“muf: ‘ﬁawmwmUazuanﬁq{l’ay‘a%ﬁﬁLﬂuém%'umsﬁa
awmﬂﬂ'lﬁgnﬁ aﬂwaﬁauﬁqm:oﬁ’mﬁﬁagmaa;ﬁu Wamwastnassddmia
(Header Part) Laz&1ua2710821880 (Body Part) E&’mﬁ"m:ﬁ%a@’%’uua:s:uu”lﬂmrﬁﬁﬁl-ﬁ
vanflaBaiies mMasutivlas udu sudeaninsezdsznavdiedayainimidn g
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2.3.3 andlunislgsuszuuaananadidnnsaind (The Right of the

Electronic Mail System)
1) DyBdld
math M szuveananedidannieingdniuezdaslasuansldnu

fudasmunnlinussusananedidnnianiindfedemaiusaninodidnnsedind
iweietnsduaefidald nmsiuanslunnldmanavildlassiradyddls (User
Account) usia3asnauiaaasiialiuimmeminudidnniefinqumeiatnoduiaeiiia
ti’iaﬁﬁty"ﬁ'gﬂ'iumﬂ‘%'amauﬁ'zmai‘é’anmmﬁa AlFmansndseananudidannaiindlulw
n“urﬂm"é‘u’lm:nmwmn‘étﬁnmaﬁna‘:‘lsﬂﬂdwnﬂmﬂ'ﬁﬁag;'luTﬂLaJmﬁmﬁ'w?aeha
Tauu ﬁaagnum‘%‘aoﬂauﬁdmaﬁﬁmﬁuﬂ?amam‘%‘m Tumanauiu gldmuninlesy
samnuaiannsefindngaudsitadfdianeegilaflanfiinslunsldszuy
IanunpBlannIennd lunssumsasesaninudidnniafindluniotnoduinesifia ff

fududmiumsiv uﬂ:a’:owv\muﬁtﬁnmaﬁn&ﬁa‘lﬁmmmﬁe"lﬁaﬂwegnﬁmmmj’ﬁﬂﬂ
fl9 :;Topﬁu‘lﬁa:d’aaﬁﬁagﬂéa%wmuﬁtﬁnmaﬁnﬁ (Electronic Mail Address) Wiadlua
LaALATE (Email Address) Llua3L YT UMAAR

2) mmﬂaaauﬁﬂ%ﬁ"l'ﬁ'

mahlFnussuneemInedEnnIeiingin e liuinseanany

“aLﬁnmaﬁné‘lﬁa:mummﬂﬁmau?m‘ﬁmmu:n'h'lﬂmumvwaumn%aﬁry%g"l:ﬁ WRZINE
WUty BT (Password) nnasfidlsdesmalinuszusananediinnseding e
L'TJumﬁJaaﬁ'u%‘nmmwﬂaaﬂﬁumm'ﬁagamauﬂfusia:ﬂu devnnisemeseudui

A A

ONABILAD g:‘l'ﬁamwndmwmuﬁﬁnmaﬁna’lﬂﬁuﬁu wWIamusotlaauaanuien

i.é

dandsnn i laaundasnng

]

2.3.4 M3lEIAnNNydLIAnNIoind 1UTINTa Netscape Messenger

WA AuNIINNT. (26543 : 33-48) lenanafesaninudianniaiing wiefl
fuudoniulasnaly E-Mail ﬁ’mﬂuﬁvnﬁuﬁ‘lﬁ%’ummﬁuumnﬁqﬂuuﬁumaﬁﬁm
suiflasnananumaiilunslfuuasanudsendalududlding mdTgReuls
E-Mail ﬁumnﬁgﬂumiﬁm@iaﬁamm“mqﬂﬂa 5319 viomssfiumslududn a1uds
M3l E-Mail sufinanuans Snalusunsy Pine Tusunsy Eudora 1usunsy Pegasus
\Iueu %aNINT Web browser 6199 171 Netscape #3a Internet Explorer fil@Huan
mIlfnuaaninedianniafing Liaae Lﬁaa‘hmum’ma:wm‘lﬁ’g‘l'ﬁ’mm'mﬁ'mwmq
vuduaasiialamslysunsuiesandor wdlideadulysunsvladaindtnisieu
dulngazaauafonu afiuandnenusanluinemusnsmzanizueslsunsaniug

Netscape Messenger LﬂuTﬂTLLniutﬁn‘] f"llaglﬂu Netscape Communicator f

17

wHRTEIaM I uNIAadaRasTunduLAaTLa dwldln Mail Laz News n113en



THnusanndonldlasasmIaGontiiuniin Browser U84 Netscape lapaanfitlu

L

. P ; ' a &
Mailbox 1ufiftananfisiBiFunlysunsy Netscape Messenger Jusnlaass

(@amwil 2.1)

7 King Mongkut's Institute of Technology Ladkrabang amyiiumniufabiw ssaoumdu-hmunmisawnselia - Netzcape

“ Y rr -

/2w il ac. th/
i = =
King Mongkut's

antumaluladwszspuinanngammimanizii

ngasdeunilramuniovio|
AET I rummInAn.
unul

T leune

210 dva.

KMITL
,Mmual Report
- B3 a

- v 4 a & -
nnn 2.4 nasdonldndsaminadiinniefindunuaniue (Status Bar)

J ; 3 = = J‘
Tufiteznann i35G unlysuny Netscape Messenger I%unlagass lasns

ﬂ‘ﬁm!:u Start > Programs> Netscape Communicator Professional Edition>

Netscape Messenger (ﬂ”amwﬁ 2.2)

= 3 - - i
nINN 2.2 msﬁun’lmnmwmumﬁnmauna‘mnﬂu Start
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“a & o -
azldulafuas Netscape Messenger Iuan (9N WA 2.3)

| need your help!

. @ | need your kind,
g Unetnger (=] bappy binhday
@ Draftr @ i need your help!
Bt ) Tents
A sen (] Coruing;)
V Trarh (=] Mhank Yourhr usng our E-cad
EE pews & Fur [Fud: Image
E’ Fll: For: Fu: comics
i T e s 47BN T LB

+ Puhah. 19NeNe 126

@ Puth Nateerwum DN E3T
¢ Pufh. 1BM3 89

o Puth Natzervwm SEMI10:48
@ Soortorn Chartinetr 12543104
& Fuh Nateerwn WENIEIT
& Sikehai THPCHSURAT 0031483
4§ chart hebaal 11503 15:35

& =Toindows-AT0Q=CA08=CT=032C0=.. 13013 150

o alede b s VISP MALMILMILM L ATRID 1047

4 y
nInn 2.3 wihaalusunsy Netscape Message
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fﬂ:LﬁWi'\Lflﬂlﬁﬂlﬁﬂﬂiﬂi“ﬂiﬂ%tﬂﬂ@?ﬂGW\N"IU'H%E!T.‘NﬁLﬂaﬁ: Inbox AT auLEND

dl ] g ﬂl W« N LA o o ' A‘ v
PWENIIATIAFDULLRZNITDIUINAANIEN EJ%LT&IG]%‘L‘N’IH F&‘l.'ﬂﬂ aamﬂ'l'm'muﬂﬂ'uuaaﬁu'lﬁ

suldsunsunew veldlusunsuniudrassanisnunssuuasdsaaninoatnals uasas

v e ] a 5 o o J
favfadany Mail Server lalunsvinan aeii

1. \8andIg4 Edit > Preferences

at G y [ @ A& de - -
2. aaniion Identity 1% Mail & Groups azdinauinuisunafawly

lueavas Identity I¥ladoyasaudrvaadlslunsaudng g duldun

. fﬁa;ﬂﬂ‘ﬁ' E-mail Address

- E-mail Address

- Address figaIn1IIA@AUNAY

- TARUILINU

' . . & { o Y v A w ' ed
- & Signature File tiwlnafidasailidnimn Ssspaszyininaiiag

fila dasn3adEnily Choose

n138$19 Signature File #319launslglusunsuyszinn Text Editor 535007

viw TUsunsa Notepad tiludu anwmemathlvldazmloununmsladasinauazaioidne

Tuwaanunolné
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a @ | a o [ v o ' Aa
3. ey TayaEINAILEIIT faune lhssimuad1ues Mail Server N3
v Ao o v A A e A oA A 4o« a ' .
wihfidansiueaninevesd |t wisdnianisdalndasiiiuganinag lagadnfidnin
_ R TR W , 4 . . .
Mail Server Ll.mi:q'ﬁa;&'l'ﬂ WaTaLATad Mail Server NLTlUNIEIIARANY (Outgoing Mail
Server) LazTUIAMANY (Incoming Mail Server) LarinuadTuaURTITIUTEY AFN OK
nuuAENule

2.3.41 N5 IHIAUNIY

(flai3un Netscape Messenger wazlusunsandladula? inbox Zuanl
wirazAw Mg Uiy 2 §u ﬁ’mummmﬂumﬁwmuﬁﬁag'lu Mail box
drusnaunihensgmiudwannang (Gamwit 2.4)

% Welcome to Netscape Communicator - Inbox - Netscape Folde:

e to Netscape & Maic Andre 2 0 3:00

lnoducing Netscap... @ In-box Direct 3!6! :I]

o i a & = [
NN 2.4 NMT2THINRINEBLANTIIDUNT

odaanssueaninsariule aanfinomssanansativrim Teaalu
sanunpazuaadliula Tamuine uathdasmuanssananoatuiwdwinlaTlwally
quidandnunu (ladasnisaweanuoativdely AANLW Next Uk Toolbar feBINTS
navluanuanansatiunaw 156& Go > Previous Message aamanuatiulafidasnis
AUt ﬂﬁnﬂummﬁufmﬁaﬂﬁnﬂu Delete aanantatuinazmeldanniiiens Tay
gnav Uil lulWiiaes Trash uazthwiled a9msauiease g WiilalWiiaes Trash uda

'
as

15@1&49 File > Empty Trash Folder

a a ' < & = ar -
ARV EALT A UUK VNATINRAUTLATAINANY (AINTWN 2.5)
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J I ° [ Lg s
AN 2.5 QMﬂﬁaanﬂiLLuuma;‘Jja‘lﬂnuawmu (Attachments)

a (] )

s "i o fﬂl v L 1 ) v a & s -
GlﬂE]ULLKGNT]‘!]G]'H&J"IHQUURHQJVLWRB%{LHU&IT@Y}U ﬂ"l@lﬂdﬂ?%ﬂuﬂ:‘.‘l? 'l‘lﬂﬂﬂﬂﬂiaﬂlllllﬂ

L&

-

{ & ol i - W i = o
aanfiasaananed Wanuuwuun ww Wanwiazuaasliinu lunsdinldlysunsuiidu
o4 a ) v A = 0w =
asausn vxilaanusedlu Inbox 1 atiu Guuaanunsan Netscape uuziiayaianeg
oo g Wiundld lladasmsldvananslml iadniy GetMsg wialdnas File > Get

3 J’ [ a A “ Qs
Message > New aziiiula$ Pop-Up Juanliila Password t@pafiufiguduinslumas
nfinseniaiauad aan oK lUsunsuazrinnisdadany Mail Server ﬁtﬂuﬁuﬂﬁﬂagTﬂu
= X J o d. -3 1 9o W 1
axiiAula’d Getting New Messages Tuanliiu lafasalauas lsunsuazsdrusanany
o o a9 o i @ = oy - ' o M v a i
91 Server ndaiaIaafilFuag Funainlaeanansnuvivazga laildidasu

a a L3 ' A - ] kg ﬂ‘; o el ‘ ] a (.
mwuaﬁaﬂ:L’ﬂum’ﬁmmmmﬂmmuumuan%’muummﬂ?awmUmﬂuagmu

2.3.4.2 N1IADUIARANY

HasuaanansiaTandadainsezaaunay Iadnilu Reply wiolda
Message > Relpy > To Sender 'lunsrﬁﬁmaumm:;&'ﬁL%'uumﬂmﬁm et iuaanune
ﬁt‘ﬁuumﬁ\ﬂﬂUmimmma:ﬁq{wmﬂﬂu fdieInInBUNALNUANNAY LFan To
Sender And All Recipients mnfuﬁa:ﬁw%ﬁumwmuﬂﬂng'fu WiauNuil Address

vasffiunazle Subject Wi3puay (amwii 2.6)

= a = a
NINN 2.6 ﬂ’]‘i@li]ﬂi]ﬂ“&l']ﬂmﬂﬂﬂ?ﬂ%ﬂﬂr
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Tumsasvsamaneideanudalitnng uddidoudasnmsladany
@unaulding ldadnty Quote w3el9%1&s File > Quote Original Text Taaudx1n
samnpazUnngiulmaninofidounaudas udddesmidmuaieslinauinazly
Fannudnvassaninounngdoniall Wimualusds Edit > Preferences udatdon
%178 Messages niudadonidanindaniny Automatically Quote Original Message
When Replying f1dasmsiiidaanududsnglasdaluia (FImwii 2.7)

L -~ Navigator
Mail & Newsgroups
f |dentity
i Mail Servers .
- Newsgroup Servers @
Addressing

L wWindow enings

|+ Copies and Folders
1 Formatting
i+ Return Receipts
L Disk Space
£l Roaming Access
¥ Composer
+]- Offline
+1- Advanced

A a & = = a 1
nInn 2.7 ﬂ'ﬁﬂﬂUﬁ]ﬂ‘PﬂI’]ﬂE)Lﬂﬂﬂ?ﬂ‘vmlﬂﬂﬂuilﬂ“u"lUL@]N]JT']H{]ﬂg

A a @ v = o ' w
Watdandannulsinguad Mllsuwsenansasuld lavezdenauringyad
FaauliunTassunInIzninedan Nu@Nn e (AINwi 2.8)

Deaear p'nueng,
I meaed you to buy s watch "G-SHOCK DW-8900".
FPlease come and sae the detail at

"http AfsAanan, casio. co. jpinaa-a/G-SHO CK/Linel pMR-G . htmli”.

It's about 14,000 baht (Thai Price)... If the price is lowear than that pleases

= ) a & =3 [
NAINN 2.8 NMIRIIARUNLBLRANNTAUNT



ol owasauduazdainyas lvadnilu Send sananpiigsluniond
FaaNANS I NS nEIiMunaATaMany > sunTariuue lWusasuanesly
andmdnle Taorimualudnas Edit > Preferences [danwada Mail & Group 97nHu
LﬁangﬂunummmLmzﬁmuﬁmmﬂumau Plain Quoted Text Beginning With “>" Is
Displayed With

2.3.4.3 n1sidanaannngatulns

as

adasmadisweamanelnal sansarildnaiitaai
1. 1dendnds Message > New Message #39
2. Adnila NewMsg %38
3. LAandd File > New > Message

Aa | o gl al & 4 ' @ &
wiiulatlnidmiudsusaninelaingis Seezutminoeiiu 2 nsay
o o A e pre W a &Y v : g & A a
niauundmiTzyTediu lanasdmisdaudaenialifld nsovdaiuiundmiy

& a

0 1 o ' o = | [ . a .
Wauaanune FInNUAAURIERIN 2 maumﬁwnaﬂm:q Subject Nuiilu Formatting
Toolbar ﬁﬁﬂ%’ulﬁ’tﬁaﬂﬂ%’ugﬂuuwmmnﬂnmwmu 270 mMsRenThavaIf1anms

=) @ u‘: L7 l‘: s & " s A
WA & JUUUL MII@NURUINURAY Huaw (A9nIWN 2.9)

P A a & a €
AN 2.9 NIV EBIRRUNBBLANNITDUNE
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) v I.: o a o L o -
Tuduzaamaszydiunu fmTuinua lenaipansm fe

To: ﬁaﬁatﬂ’%’uamﬁm
Cc: ﬁoﬁa;&’%’umnndw 1 au Wdaurinssium

(Cc = Carbon Copy)
Bcc: safvgFuannndn 1 au Tasfiudazauazlal
nuigsE L lasing
(Bcc = Blind Carbon Copy)

Group: dmiudssanunslinguin
Reply-to: NNIADUIARUTBNAL
Followup-to: farananouuda lUdigou

AEmsthouGunnesyfedivlutes To : ddasmsladmumnegli
1Az Enter 9MNUUNATNEB4398M"3 Dropdown List anliian 1ian Ce: udrRuwTagiy
o W s ° L ole [ o | &/ s Y - . .
lugreudaly viusuilauasuaadedns sdunainliszyde Subject lunsau Subject
P = a - eV v g w = v AL e A = & =
Faluanuiluadaersrynie lifld wddmzyitialifiunnudGasidouiooimiy

Foufiuezly nsufasdedipweanany lavsmatsmaaniUiuudng ldan

. i - ' o oA sl A = = o L ] v a
Formatting Toolbar dsaziinenistion g Widenlddn Waliswaiudaszalindnyy
Send

2.3.4.4 nvsunuldalunsaanuaanang
A a o A o Y
aanansfdonliny Netscape Messenger “wananuREaIN L
v & - € w [ =) Clleio) o o)
EmuumnTGﬂumm:amwamnmn"lw!avlﬂwsaunmwmmﬂumwm:miﬂmu Wae
~ 9 o ol =2 & J ﬂ' a WA = 9 J
RIINTOLAUNA LA U mLﬂummqwumm‘tﬂﬂmnm‘lmuﬂ'nuuuu'l.unﬁ'lfnmnmu
- Ad v e o e o o wo ane
Fon 9 lunsdidilpudasnmuuulwdliwiaunuaanany Wivndai
1. ANy Attach w3alT@1as File>Attach> anwwlisunsuazliienin
dsasls denvalysunsuasdadulaslnaliideliiaanitasin lwannilaunyly
2. \ilpvzyFouden Lazadn Open e 'ﬂ:Lﬁu%a'le‘aw%auﬁag’Lun‘sau

Attachment

o o [ a
2.3.4.5 msaﬂmaqﬂuuﬁnnag

- A oA & a A A ° [N
ﬁymuuﬁnﬂagwia Address Book Liuanganibananunsovinlednelu

e -3 as J
Netscape laaf3TnIvineah

1
" .

1. Budsminanidanaanunslu Inbox ﬁﬁaamsﬂuﬁnﬁaglﬁuvﬁ’
2. l5é1&3 Message > Add to Address Book > Sender
3. Tdsunsuazlladulad Card for anliwiauriuiize winana uas
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¥ ' ]
E-Mail Address 19961 fsfeanisiisiiindayadnus] i Nickname fianunsaiuiidnlals

dlalgessusasudanin oK iuedu

lunsdifidaanisairoes IWiila Address Book laeldsnds Communicator
> Address Book 9z#3ulaiua4 Address Book ﬂﬁﬂg%’u ANty New Card nunsan
‘:ma:fé‘umﬁﬁaamﬂumpudwc] 8191 First Name, Last Name, E-Mail Address L&3aU&2
Aan OK aztFusremsluiusnngisdulu Address Book

grumyhanld adanind suaanansud 'lud’m'?'i*s:q%ag’%'nlﬁ'ﬂﬁn
1Ju Address 32183ula T Select Address InuAdNTafidaINs ududandinnvdiine:
folanzadnuLAsInIavraL dudw Lﬁaﬂﬁngn@‘i’muﬁa findn OK Landusanymi
WiwIAnANY Address 'ﬁLﬁan‘l’Tﬂ:mﬁ'ﬂnglud’auuuﬁlﬂummaamﬁ'za_ql Address
AUGHBINTT

- A l‘:‘ J a v = - [l { - {
Tumaidpasei i3 RS NUNITURADNANADITILFAUNORDULFETN 1309

3
o a a & a. g & - o &
mslaanindanniaiing lasiifitamninag 3 unisewu aok
Y ﬂ’lﬂt%tﬂ']ﬂ’]‘il‘ﬂ"’lf‘f[ﬂ‘mﬂ'm Netscape Communicator
2. MIAaa9lLsunIN Netscape Messenger

3. msldeemansdidnniafing lusunsa Netscape Messenger

2.4 UNISERADNN N DIBTIUFAW

2.41 AMNRNIBVDILNITHRADNNIADITIVADW

unSuuaaNRaaitiuganinNNAINI¥IING I Computer Assisted
Instruction (CAI) - faaiiudimslidndavasunSounsuiainaiziorenlummainny
waedn Safianumanoguidsiu (T la%aqa. 2543 : 5) leiur

CAIl (Computer Assisted Instruction)

CAL (Computer Assisted Learning)

CAT (Computer Aided Teaching)

CBI (Computer Based Instruction)

CBT (Computer Based Teaching)

ANMURNLTDILUNITUUABNAUNADTTI0REY LRUNNTANMRASYITUIR
anununoan Ly daft

3¢ Inpwndis (2527 : 10) nanai aenRaAeiTasFewIuATITTUD
aauRnaefiiudelwilam3oemy Humsdoulasass uasiumsSouuuy Interacting

TeR NS suNUaaNRILaas
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[ 127717904 (2531 1 121) naeesuRaeitisrewdumTin
aanfaasullumsssunisaon nunw MivnuuuEniarienisianalaslusunsn
= o P a o O = a =3 o \ °

AauRAT eI uazdaudTnIRauunwinAL LY asuRteeTazanin
| ] [ J o s L= [
‘1mL‘%uuﬁm?uuvl,i'amommzuumlaua‘lugﬂLLun‘nmm:aummugnuuum:ﬂu
a & ' ' - [ =2 o
Piiwgn T (2532 : 8) naiReNRIAaTTIEAN nUNBDY M
- 6 V& d' - = c; A’ a =] ar
asufaatinlfiwesosiialumaFouniszan lasfitien it uwuuHnia uaz
a J ) J = "
memaua:gnwwmmumlugﬂmaa'[ﬂmnmﬂauwamaﬁ’ #9138N731 Courseware
Qe =} =Y ) A‘ =3 i [ ﬂ‘:
rdnuuazﬁ‘muummmﬂnﬂaummai‘ Tasnauf@asriunsotauatanidsNanadung
FIMIIRaUAzNTIWAAT susnoNsIINY i’uﬁmaumn@l‘%’uu FUITNATIVA A DUURAD
nanTTeuluguasioysdouwnay (Feedback) Turigizou
T TAaBEnY (2535 : 32) IWaaumaneindumsrenilineufiaes
TILRDW -
ystur sudt (2541 :14) ldeBinedl CAlfla unSunaauiiine T iuaen

L5

i fdlugomsidounisaen inilauudula (Transparency Film) &laq (Slide) v3a
Sevient (Video) filfussnaunisaen T@uﬁqw‘wmmﬁa'ﬁ?n‘lﬁgﬁwrﬂ’ﬂ%i:uu
AoufiLaesinadumeluamaudina AN IanUTERIdTa LT WasanTysunsa
UniEuunouRaLdaTtInaan (CAI) Hnaua lenan W (Hua sansUHFIWUT (Interaction)
AudFuuld $ovimihitldasumeaelunsduaiu unzmIugNMILEUa leeI0AI789
Tovunsues Fondt Saewnviasl wia Sa@Tds (Multimedia) vYinlWdszndauazd
UssRnTnnannnitmaSeumIsrenlng LLa:ﬂ’ammmm:eé’u'lﬁ'pjf%uuamm‘%uu LA
apnTivzAnwua L‘%ﬂ%ﬁmﬁﬂu"l.ﬁﬁamul,ao

qu,l.ﬁ’a AITMNINT (2542 1 65) MAAuMANEd1 CA aneTia ATN19183
NIROUTIBYAARLAL pd A EINTIUaNA s sIRaIRaa s ARrdewi L srRunTol ATl
AuEIWRETY Tmsusesifarenudeufidnanudas unGeullsunsafieon et
mmmuﬂauﬁamai"fhzlaau‘%aLﬂum*a:aaﬁmhﬂaauammﬁaﬁsjﬁuuﬁaummaaﬁﬂug}’ﬁ
waaIlHuananTINeN99 figaumesanmmw N:L%U'Lﬁl:ﬂaUﬁ’lﬂ’]MﬂWOLLﬂuﬁuﬁ LEAIBEN
mmwamwﬁﬁgagﬂmwLLa:ﬁwﬂfaﬁaﬁ"ﬁamoﬁaﬂml'ﬁi'auﬁ'uﬁ'uqﬂns:ﬁaﬂ'ﬁaﬁ'ucﬁ’m LT
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1. MIIAMILNGTUH
1.1 mebiausfaFemanvesuniou 433 | 057 g
1.2 mm’nmwm’lﬂuyuuuﬁmm:au 4.00 | 0.00 @
1.3 lﬁ’ﬂ‘l’ﬂﬂﬂLLR:ﬂ’]‘SLtH:ﬁ‘ﬂ%ﬂ’]ﬂ'ﬁUﬂL?U‘H 466 | 0.57 fun
14 AMURZAINUALAINARDIND 433 | 0.57 @
1.5 anutaanvesimlumsldauvesudss | 433 | 057 g
UNniIen
1.6 mIsanuuuningalasmwiiu 5.00 | 0.00 fun
1.7 A5nildasurasunGeu lasnwsy 4.00 | 0.00 @
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2.4 311Lmu'umﬁaé’nmﬁ‘lﬂumsﬁ‘uma 433 | 057 @
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2.7 anuldutavsaatanisdauiiin 5.00 | ©.00 fann
2.8 MIIAIWEUMHIVBIAIDNWINAIZFULS | 5.00 | 0.00 fan
nodamatle
FAUANUAINEFUT IS W ILAE R RS INTY 483 | 0.25 dun
Ao lasniwiia 462 | 037 flann
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ATUWWLAN 32 AZUWY

AdnousaaRe AZUWBKAINNITHIAT E1 SUWHIN
) unfi 1| undi 2 | undl 3 | Tmezuun | n1swaan E2

1 9 8 12 29 28

2 9 9 14 32 32

3 9 8 11 28 27

4 9 8 11 28 28

5 9 9 12 30 29

6 9 9 %3 31 30

T 9 7 12 28 25

8 9 9 14 32 32

9 9 5 12 26 28

10 9 8 12 29 28
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